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This tab includes resources to help you learn more about Cisco Unified Communications.
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Solution Reference Network Design
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Component Resources

Cisco Unified Communications System Demo

System Compatibility Tool

Ordering Guides
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Cisco Unified Workspace Licensing
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System Description

System Release Notes

System Installation and Upgrade Manual

System Test Results

System Description
System Description for Cisco Unified Communications System, Release 6.0(1)

System Release Notes
System Release Notes for Contact Center: Cisco Unified Communications System, Release 6.0(1)
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System Installation and Upgrade Manual
System Installation and Upgrade Manual for Contact Center: Cisco Unified Communications System, 
Release 6.0(1)

System Test Results
This topic summarizes the results of Cisco Unified Communications Release 6.0(1) system testing for 
contact center environments. This topic contains the following sections:

 • Testing Objectives

 • Tested Deployment Models and Sites

 • Test Results

Testing Objectives

Cisco Systems validates Cisco Unified Communications systems by designing, installing, configuring, 
and testing hardware and software to achieve a predictable, effective, and reliable system. The intent of 
system testing is to validate the seamless interoperability and stability of the components that make up 
a complete and optimized Cisco Unified Communications system.

Testing performed for Cisco Unified Communications includes (but is not limited to) the following:

 • Installation, Upgrade, and Usability Testing—To verify software installation and upgrades at the 
system level and usability for system components 

 • End-to-End Functionality Testing—To verify the end-to-end functionality of system components

 • Basic Functionality and Feature Testing—To verify basic call flows and component features

 • Customer Assurance Program (CAP) Scenario Testing—To re-create and test CAP scenarios based 
on TAC input

 • Interoperability Testing—To verify the interoperability among system components

 • Scalability Testing—To verify system functionality during scalability tests

 • Performance, Load, and Stress Testing—To verify system functionality during performance, load, 
and stress tests

 • Failover, Recovery, and Redundancy Testing—To verify system behavior during failover and 
recovery, and behavior in redundant configurations

Tested Deployment Models and Sites

Several deployment models and sites were designed and tested as part of Cisco Unified Communications 
System Release 6.0(1) for Contact Center. For information about the hardware and software 
components, configurations, and environment tested and verified for interoperability in this system 
release, see Test Deployment Models and Sites.

Test Results

The results of the system tests performed for contact center during Cisco Unified Communications 
Release 6.0(1) are shown in the System Test Results.
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The test results contain the following information:

 • Title—Title of the test.

 • ID—Identifier for the test.

 • Description—Description of the purpose of the test.

 • Features Tested—Component feature tested.

 • Status—Result of the test and any defects related to the test case. Possible values are:

 – Passed—Test case passed as described in the table.

 – Failed—Test case failed and the reason is described in the listed defect.

 – Passed with exception—Test case as described passed but an anomaly occurred that was not 
directly related to the functionality being tested. Possible anomalies are as follows: 

The test steps were modified based on the actual feature implementation.

The test setup was modified based on the actual feature implementation.

The test results did not exactly match what was expected although the feature performed as 
required. 

 • Defects—Identifier for any defect that was opened against the test. If you have an account with 
Cisco.com, you can use the Bug Toolkit to view information about defects.

To access the Bug Toolkit, go to this URL:

http://tools.cisco.com/Support/BugToolKit/

Solution Reference Network Design
Solution Reference Network Design (SRND) guides provide considerations and guidelines for 
deploying components for the Cisco Unified Communications System. SRND resources are available at 
http://www.cisco.com/go/srnd.

Network Topology Resources
This topic provides topology resources you can use to document network plans. Specifically, it includes:

 • Microsoft Visio Network Topology Diagrams as individual Microsoft Visio files

 • How to Use Microsoft Visio Drawings Efficiently for best practices in using Microsoft Visio files

Microsoft Visio Network Topology Diagrams
You can download zip files containing Visio drawings of the logical and physical topologies for the 
contact center sites that are documented in Test Deployment Models and Sites. Table 7-1 identifies the 
Visio drawings in each zip file.

Note You need Microsoft Visio 2003 to open the files.

If you need to create new Visio drawings, you can use the Cisco Visio stencils located at the Visio 
Stencils resource page.
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Table 7-1 Network Topology Diagrams for Contact Center 

Description Filename

Zip file includes logical and physical 
drawings in Test Bed 1 as listed below.

UC601_TB1_Topologies.zip (right-click to download 
zip) 5.6 MB

Note If you click the link rather than right-click, the 
zip file may open in the secondary window but 
also replace the contents of this window. Use 
your Back button to return to this window.

Unified IP IVR Sites in Test Bed 1 UC601_IPCC_CCM_Logical_ALL.vsd

Site 1 IP IVR Logical Topology UC601_IPCC_CCM_Logical_Site1.vsd

Site 2 IP IVR Logical Topology UC601_IPCC_CCM_Logical_Site2.vsd

Site 3 IP IVR Logical Topology UC601_IPCC_CCM_Logical_Site3.vsd

Site 4 IP IVR Logical Topology UC601_IPCC_CCM_Logical_Site4.vsd

Site 5 IP IVR Logical Topology UC601_IPCC_CCM_Logical_Site5.vsd

Site 6 IP IVR Logical Topology UC601_IPCC_CCM_Logical_Site6.vsd

Site 7 IP IVR Logical Topology UC601_IPCC_CCM_Logical_Site7.vsd

Site 8 IP IVR Logical Topology UC601_IPCC_CCM_Logical_Site8.vsd

Site 1 IP IVR Physical Topology UC601_IPCC_CCM_Physical_Site1.vsd

Site 2 IP IVR Physical Topology UC601_IPCC_CCM_Physical_Site2.vsd

Site 3 IP IVR Physical Topology UC601_IPCC_CCM_Physical_Site3.vsd

Site 4 IP IVR Physical Topology UC601_IPCC_CCM_Physical_Site4.vsd

Site 5 IP IVR Physical Topology UC601_IPCC_CCM_Physical_Site5.vsd

Site 6 IP IVR Physical Topology UC601_IPCC_CCM_Physical_Site6.vsd

Site 7 IP IVR Physical Topology UC601_IPCC_CCM_Physical_Site7.vsd

Site 8 IP IVR Physical Topology UC601_IPCC_CCM_Physical_Site8.vsd

Zip file includes logical and physical 
drawings in Test Bed 2 as listed below.

UC601_TB2_Topologies.zip (right-click to download 
zip) 4.3 MB

Note If you click the link rather than right-click, the 
zip file may open in the secondary window but 
also replace the contents of this window. Use 
your Back button to return to this window.

Parent and Child Sites in Test Bed 2 UC601_IPCC_PC_Logical_ALL.vsd

Site 1 Parent and Child Logical 
Topology

UC601_IPCC_PC_Logical_Site1.vsd

Site 4 Parent and Child Logical 
Topology

UC601_IPCC_PC_Logical_Site4.vsd

Site 5 Parent and Child Logical 
Topology

UC601_IPCC_PC_Logical_Site5.vsd

Site 9 Parent and Child Logical 
Topology

UC601_IPCC_PC_Logical_Site9.vsd
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How to Use Microsoft Visio Drawings Efficiently
Microsoft Visio allows you to bring drawings into several applications (for example, Microsoft Word, 
PowerPoint). Unfortunately, the default method is to insert the whole “Visio object” into a file. This can 
cause problems.

When you copy and paste a Visio drawing into another application, the Visio object includes all the 
application data with the drawing. This object information is needed if you want to be able to 
double-click the drawing from Word or PowerPoint and have it open in Visio for editing. But pasting as 

Site 1 Parent and Child Physical 
Topology

UC601_IPCC_PC_Physical_Site1_Parent.vsd

Site 4 Parent and Child Physical 
Topology

UC601_IPCC_PC_Physical_Site4_Parent.vsd

Site 5 Parent and Child Physical 
Topology

UC601_IPCC_PC_Physical_Site5_Child.vsd

Site 9 Parent and Child Physical 
Topology

UC601_IPCC_PC_Physical_Site9_Child.vsd

Zip file includes logical and physical 
drawings in Test Bed 3 as listed below.

UC601_TB3_Topologies.zip (right-click to download 
zip) 8.8 MB

Note If you click the link rather than right-click, the 
zip file may open in the secondary window but 
also replace the contents of this window. Use 
your Back button to return to this window.

Unified CVP Sites in Test Bed 3 UC601_IPCC_CVP_Logical_ALL.vsd

Site 1 CVP Logical Topology UC601_IPCC_CVP_Logical_Site1.vsd

Site 2 CVP Logical Topology UC601_IPCC_CVP_Logical_Site2.vsd

Site 3 CVP Logical Topology UC601_IPCC_CVP_Logical_Site3.vsd

Site 5 CVP Logical Topology UC601_IPCC_CVP_Logical_Site5.vsd

Site 6 CVP Logical Topology UC601_IPCC_CVP_Logical_Site6.vsd

Site 7 CVP Logical Topology UC601_IPCC_CVP_Logical_Site7.vsd

Site 8 CVP Logical Topology UC601_IPCC_CVP_Logical_Site8.vsd

Site 1 CVP Physical Topology UC601_IPCC_CVP_Physical_Site1.vsd

Site 2 CVP Physical Topology UC601_IPCC_CVP_Physical_Site2.vsd

Site 3 CVP Physical Topology UC601_IPCC_CVP_Physical_Site3.vsd

Site 5 CVP Physical Topology UC601_IPCC_CVP_Physical_Site5.vsd

Site 6 CVP Physical Topology UC601_IPCC_CVP_Physical_Site6.vsd

Site 7 CVP Physical Topology UC601_IPCC_CVP_Physical_Site7.vsd

Site 8 CVP Physical Topology UC601_IPCC_CVP_Physical_Site8.vsd

Table 7-1 Network Topology Diagrams for Contact Center (continued)

Description Filename
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an object adds many megabytes to the size of your file. With only a few such drawings, a Word document 
can bloat from 300 KB to 12 MB, making it troublesome to share among authors or reviewers, and a trial 
for partners or customers to download.

Bringing a Visio Drawing into a Document

Unless you really need the live editing capability, avoid unnecessary file bloating by performing the 
following steps when you paste:

Step 1 In Visio, copy the drawing as you normally do. Tip: Ctrl-C copies the whole drawing.

Step 2 At the desired location in the destination document, choose Edit > Paste Special. In the Paste Special 
dialog box, choose Picture (Windows Metafile). 

Step 3 Click OK. The drawing is inserted as an ordinary picture. If it is not positioned properly, choose Format 
> Picture, click the Layout tab and select In line with text.

The Bottom Line

Do not use the paste default (Edit > Paste or Ctrl-V) to paste Visio drawings. Always use Paste Special. 

Downsizing Existing Drawings

If a document is larger than it should be, you can check to see if the Visio drawings are the reason and, 
if so, fix the problem.

Step 1 With the drawing selected in the Word or PowerPoint document, choose Edit. At the bottom of the Edit 
menu, you will see one of the following:

 • Edit Object, if the drawing was inserted by simple pasting. It is a Visio object and taking up much 
more file space than it needs to. Go on to Step 2. 

 • Edit Picture, if the drawing was inserted properly, as a picture. It is not the source of the large file 
size. 
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Step 2 If the drawing is an object, cut it (Ctrl-X), and then repaste as in Bringing a Visio Drawing into a 
Document.

Tip You can easily click through the document to check each picture by using the Go To feature in Microsoft 
Word. Where you want to start searching, press Ctrl-G. In the Go To What list, select Graphic and click 
Next. You go to the next graphic. Click it to select and then check as in Step 1. If needed, repaste as in 
Step 2. Click Next and continue these steps for other graphics.

Component Resources
Component Resources Documentation

Configuration Command Files

Component Resources Documentation
Table 7-2 provides links to the main page for documentation on various Cisco Unified Communications 
components, from which you can navigate to individual documents. For documentation on specific tasks, 
see Component Installation and Configuration Guides on the Implement tab. For documentation on other 
Cisco products, go to http://www.cisco.com/go/techdocs.

Table 7-2 Component Resources Documentation for Contact Center 

Category Component Documentation URLs

Call Control Cisco Unified Communications Manager http://www.cisco.com/en/US/products/sw/voicesw
/ps556/tsd_products_support_series_home.html

Cisco Unified Presence http://www.cisco.com/en/US/products/ps6837/tsd
_products_support_series_home.html

Contact Center Cisco Unified Intelligent Contact 
Management and Cisco Unified ICM 
Support Tools (Server and Agent) 

http://www.cisco.com/en/US/products/sw/custcos
w/ps1001/tsd_products_support_series_home.htm
l

Cisco Unified Contact Center Enterprise http://www.cisco.com/en/US/products/sw/custcos
w/ps1844/tsd_products_support_series_home.htm
l

Cisco Customer Response Solutions 
(Unified IP IVR)

http://www.cisco.com/en/US/products/sw/custcos
w/ps1846/tsd_products_support_series_home.htm
l

Cisco Unified Customer Voice Portal http://www.cisco.com/en/US/products/sw/custcos
w/ps1006/tsd_products_support_series_home.htm
l

Computer Telephony Integration Object 
Server (CTI OS) and Agent Desktop

http://www.cisco.com/en/US/products/sw/custcos
w/ps14/tsd_products_support_series_home.html

Cisco Agent Desktop (CAD) Server and 
Agent Desktop

http://www.cisco.com/en/US/products/sw/custcos
w/ps427/tsd_products_support_series_home.html

Voice Mail and Unified 
Messaging

Cisco Unity Connection http://www.cisco.com/en/US/products/ps6509/tsd
_products_support_series_home.html
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End Points and Clients Cisco IP Communicator http://www.cisco.com/en/US/products/sw/voicesw
/ps5475/tsd_products_support_series_home.html

Cisco Unified IP Phones http://www.cisco.com/en/US/products/hw/phones/
ps379/tsd_products_support_series_home.html

Network Management Cisco Unified Operations Manager http://www.cisco.com/en/US/products/ps6535/tsd
_products_support_series_home.html

Security Cisco Catalyst 6500 Series Switch 
Firewall Services Module (FWSM) 

http://www.cisco.com/en/US/products/hw/module
s/ps2706/ps4452/tsd_products_support_model_ho
me.html

Cisco Adaptive Security Appliance 
(ASA) 5540 Services

http://www.cisco.com/en/US/products/ps6120/tsd
_products_support_series_home.html

CiscoWorks Management Center for 
Cisco Security Agents

http://www.cisco.com/en/US/products/sw/cscowo
rk/ps5212/tsd_products_support_series_home.htm
l

Cisco Security Agent for Unified 
Communications Manager 

http://www.cisco.com/en/US/products/sw/voicesw
/ps556/tsd_products_support_series_home.html

Cisco Security Agent for Customer 
Response Solutions 

http://www.cisco.com/en/US/products/sw/custcos
w/ps1846/tsd_products_support_series_home.htm
l

Cisco Security Agent for Unified 
Intelligent Contact Management 

http://www.cisco.com/en/US/products/sw/custcos
w/ps1001/tsd_products_support_series_home.htm
l

Cisco Security Agent for Unified 
Customer Voice Portal 

http://www.cisco.com/en/US/products/sw/custcos
w/ps1006/tsd_products_support_series_home.htm
l

Table 7-2 Component Resources Documentation for Contact Center (continued)

Category Component Documentation URLs
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Communications 
Infrastructure

Cisco 3725, 3745 (Unified CVP VXML 
voice/data, H.323, SIP, and MGCP 
gateways)

http://www.cisco.com/en/US/products/hw/routers/
ps282/tsd_products_support_series_home.html

Cisco 3825, 3845 (Unified CVP VXML, 
voice/data, H.323, SIP, and MGCP 
gateways)

http://www.cisco.com/en/US/products/ps5855/tsd
_products_support_series_home.html

Cisco AS5400HPX, AS5400XM (Unified 
CVP VXML voice, H.323, and PSTN 
gateways)

http://www.cisco.com/en/US/products/hw/univgat
e/ps505/tsd_products_support_series_home.html

Cisco AS5850 (PSTN and voice gateway) http://www.cisco.com/en/US/products/hw/univgat
e/ps509/tsd_products_support_series_home.html

Cisco 3745 (gatekeeper) http://www.cisco.com/en/US/products/hw/routers/
ps282/tsd_products_support_series_home.html

RSVP Agent (on 37xx and 38xx 
platforms)

http://www.cisco.com/en/US/products/hw/routers/
ps282/tsd_products_support_series_home.html

Cisco 7206 (core/WAN router) http://www.cisco.com/en/US/products/hw/routers/
ps341/tsd_products_support_series_home.html

Cisco 871 router http://www.cisco.com/en/US/products/hw/routers/
ps380/tsd_products_support_series_home.html 

Cisco Catalyst 3750 (access switch) http://www.cisco.com/en/US/products/hw/switche
s/ps5023/tsd_products_support_series_home.html

Cisco Catalyst 6506, 6509 (core switch, 
Supervisor 2)

http://www.cisco.com/en/US/products/hw/switche
s/ps708/tsd_products_support_series_home.html

Cisco Catalyst 6506, 6509 (MSFC, 
Supervisor 2)

Cisco CSS 11501 Content Services 
Switch 

http://cisco.com/en/US/products/hw/contnetw/ps7
92/tsd_products_support_series_home.html

Cisco Communication Media Module 
(CMM)

http://cisco.com/en/US/products/hw/switches/ps7
08/tsd_products_support_series_home.html

Wireless Cisco Aironet Access Point 1240AG http://www.cisco.com/en/US/products/ps6521/tsd
_products_support_series_home.html

Call Control Cisco Unified Communications Manager http://www.cisco.com/en/US/products/sw/voicesw
/ps556/tsd_products_support_series_home.html

Cisco Unified Presence http://www.cisco.com/en/US/products/ps6837/tsd
_products_support_series_home.html

Table 7-2 Component Resources Documentation for Contact Center (continued)

Category Component Documentation URLs
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Configuration Command Files
You can download sample configuration files from Table 7-3 for the call flow components described in 
Tested Call Flows.

Contact Center Cisco Unified Intelligent Contact 
Management and Cisco Unified Contact 
Center Enterprise 

http://www.cisco.com/en/US/products/sw/custcos
w/ps1001/tsd_products_support_series_home.htm
l

Cisco Unified ICM Support Tools (Server 
and Agent) 

http://www.cisco.com/en/US/products/sw/custcos
w/ps1844/tsd_products_support_series_home.htm
l

Cisco Customer Response Solutions 
(Unified IP IVR)

http://www.cisco.com/en/US/products/sw/custcos
w/ps1846/tsd_products_support_series_home.htm
l

Cisco Unified Customer Voice Portal http://www.cisco.com/en/US/products/sw/custcos
w/ps1006/tsd_products_support_series_home.htm
l

Table 7-2 Component Resources Documentation for Contact Center (continued)

Category Component Documentation URLs

Table 7-3 Sample Call Flow Component Configuration Files 

Description Filename

Test Bed 1 Call Flows: Cisco Unified 
Communications Manager Post-Routed Call Flow 
Components 

CCM_Config.zip (right-click to download 
zip) includes the files below.

Note If you click the link rather than 
right-click, the zip file may open in 
the secondary window but also 
replace the contents of this window. 
Use your Back button to return to 
this window.

Site1 Cisco 3825 Gatekeeper3 cs1-3825-gk3.txt

Site1 Cisco 7206VXR Router cs1-7206.txt

Site1 Cisco CMM Gateway1 cs1-cmm-gw1.txt

Site1 Cisco CMM Gateway2 cs1-cmm-gw2.txt

Site2 Cisco 7206VXR Router cs2-7206.txt

Site3 Cisco 7206VXR Router cs3-7206.txt

Site4 Cisco 3745 Gatekeeper3 cs4-3745-gk3.txt

Site4 Cisco AS5400HPX Gateway1 cs4-5400-gw1.txt

Site4 Cisco AS5850 Gateway1 cs4-5850-gw1.txt

Site4 Cisco 7206VXR Router cs4-7206.txt

Site5 Cisco 7206VXR Router cs5-7206.txt

Site5 Cisco CMM Gateway1 cs5-cmm-gw1.txt
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Site6 Cisco 3745 Gateway1 cs6-3745-gw1.txt

Site6 Cisco 3745 Gateway2 cs6-3745-gw2.txt

Site6 Cisco 7206VXR Router cs6-7206.txt 

Test Bed 2 Call Flows: Parent and Child Call Flows PC_Config.zip (right-click to download 
zip) includes the files below.

Note If you click the link rather than 
right-click, the zip file may open in 
the secondary window but also 
replace the contents of this window. 
Use your Back button to return to 
this window.

Site1 Cisco 3745 Gatekeeper1 pcs1-3745-gk1.txt

Site1 Cisco 3745 Gatekeeper2 pcs1-3745-gk2.txt

Site1 Cisco 3745 Gateway1 pcs1-3745-gw1.txt

Site1 Cisco 7206VXR Router pcs1-7206.txt

Site4 Cisco 3745 Gatekeeper1 pcs4-3745-gk1.txt

Site4 Cisco 3745 Gatekeeper2 pcs4-3745-gk2.txt

Site4 Cisco 3745 Gateway1 pcs4-3745-gw1.txt

Site4 Cisco 7206VXR Router pcs4-7206.txt

Site9 Cisco 3745 Gatekeeper1 pcs9-3745-gk1.txt

Site9 Cisco 7206VXR Router pcs9-7206.txt

Site9 Cisco CMM Gateway1 pcs9-cmm-gw1.txt

Test Bed 3 Call Flows: Cisco Unified Customer Voice 
Portal Post-Routed Call Flow Components 

CVP_Config.zip (right-click to download 
zip) includes the files below.

Note If you click the link rather than 
right-click, the zip file may open in 
the secondary window but also 
replace the contents of this window. 
Use your Back button to return to 
this window.

Site1 Cisco 3745 Gatekeeper1  ps1-3745-gk1.txt 

Site1 Cisco 3745 Gatekeeper2  ps1-3745-gk2.txt

Site1 Cisco 6509 Switch1   ps1-6509-SW1.txt

Site1 Cisco 7206VXR Router   ps1-7206.txt

Site1 Cisco Content Services Switch1 ps1-css1.txt

Site3 Cisco AS5400HPX Gateway2 ps3-5400-gw2.txt

Site3 Cisco AS5400HPX Gateway3 ps3-5400-gw3.txt

Site3 Cisco 6506 Router ps3-6506-rtr.txt

Site3 Cisco 6506 Switch1 ps3-6506-SW1.txt

Table 7-3 Sample Call Flow Component Configuration Files (continued)

Description Filename
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Cisco Unified Communications System Demo
The capabilities of a Cisco Unified Communications solution can be demonstrated using the Demo 
Remote [Internal] tool. Demo Remote is a mobile, web-based demonstration platform that allows sales 
personnel to demonstrate a wide variety of Cisco solutions in Cisco offices or at customer sites using the 
Cisco VPN Client or a small mobile endpoint kit. Demonstrations are scripted, easy to use, and allow 
full administrative access during the demonstration session.

The Cisco Unified Communications Demonstration highlights key components and features of the Cisco 
Unified Communications solution. The demo offers a full set of business telephony features and a 
complete IP-based applications portfolio including voice, unified communications, mobility, presence, 
conferencing services and video. The demo is intended for medium to large customers with a need for 
integrated voice, video, and unified communications.

System Compatibility Tool
The Cisco Unified Communications Compatibility Tool provides tables that identify the compatible 
software release versions for each product element in each Cisco Unified Communications release.

Ordering Guides
Ordering guides for most Cisco Unified Communications products are available for partners and Cisco 
employees. For information on ordering guides, go to the following URL:

http://www.cisco.com/web/partners/sell/technology/ipc/announcements/ 
unified_communications_system_6_launch.html 

Click the “What is available for Partners” tab to view a list of the ordering guides and other marketing 
collaterals.

Site5 Cisco 6509 Router ps5-6509-rtr.txt

Site5 Cisco Content Services Switch2 ps5-css2.txt

Site6 Cisco AS5400HPX Gateway2 ps6-5400-gw2.txt

Site6 Cisco AS5400HPX Gateway3 ps6-5400-gw3.txt

Site6 Cisco AS5400HPX Gateway4 ps6-5400-gw4.txt

Site6 Cisco AS5400HPX Gateway5 ps6-5400-gw5.txt

Site6 Cisco PSTN/VXML Gateway2 ps6-pstn-vxml-gw2.txt

Site8 Cisco PSTN Gateway1 (with Unified Presence) ps8-pstn-gw1-cup.txt

Site8 Cisco 3845 SIP VXML Gateway1 (with Unified 
Presence)

ps8-3845-gw1-vxml-cup.txt

Table 7-3 Sample Call Flow Component Configuration Files (continued)

Description Filename
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End-of-Sale and End-of-Life Products
The end-of-sale (EOS) date is the last date to order the product through Cisco point-of-sale mechanisms. 
The product is no longer for sale. There is also an end-of-life (EOL) process that guides the final business 
operations associated with the product life cycle.

The EOL process consists of a series of technical and business milestones and activities that, once 
completed, make a product obsolete. Once obsolete, the product is not sold, manufactured, improved, 
repaired, maintained, or supported.

For information about recommended replacements, see the comprehensive list of announcements at the 
following URL:

http://www.cisco.com/en/US/products/prod_end_of_life.html

For information on specific products, choose a product from the following URL:

http://www.cisco.com/go/techdocs

Then click on the End-of-Life and End-of-Sale Notices link in the Product Literature box.

For an overview of the Products and Services EOL policy, see the information at the following URL:

http://www.cisco.com/en/US/products/products_end-of-life_policy.html

Cisco Unified Workspace Licensing
Cisco Unified Workspace Licensing is an easy, affordable program for procurement of a broad range of 
Cisco Unified Communications applications and services. Unified Workspace Licensing facilitates 
consistent deployment of multiple applications to all users in their workspaces and helps organizations 
maximize the potential of unified communications. 

This program streamlines pricing, licensing, and deployment of Cisco Unified Communications 
solutions and enables organizations to implement a media-rich unified communications experience at a 
cost-effective user basis.

Troubleshooting Individual Components
For a list of the diagnostic tools and supporting troubleshooting documentation available for most 
components in a contact center network, see Contact Center Component Troubleshooting Tools and 
Documentation on the Implement tab.

To search for support for a product or to find technical information on products, solutions, and 
technologies, go to the following URL:

http://www-tac.cisco.com/Support_Library

Documentation Wiki
The Cisco documentation wiki (DocWiki) contains information on a number of Cisco product-related 
topics. Among these is a category for Cisco Unified Communications Systems, which currently includes 
topics for:
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 • Unified Communications System Design: This topics includes information and tutorials on design 
tools such as the Cisco Unified Communications Sizing Tool, which can be used to design and model 
solutions for existing and prospective customers.

 • Unified Communications System Implementation: This topic includes information on installing and 
configuring system components, and provides detailed configuration examples based on tested 
deployment models.

 • Unified Communications System Operations: This topic includes information on the tasks you need 
to perform to maintain and optimize your system and keep it operating as trouble-free as possible. 
These tasks are broken down into two areas: one-time and infrequent tasks, and regular and 
scheduled tasks.

 • Unified Communications System Troubleshooting: This topic includes information that will assist 
you with isolating and resolving problems you may have with Unified Communications system 
components. This topic offers sections for system troubleshooting methodology and commonly 
encountered problems.

For additional  Cisco Unified Communications topics posted on the Cisco documentation wiki, see 
http://docwiki.cisco.com/wiki/Cisco_Unified_Communications.
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